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MODUL 1 

PEMBAHASAN TENTANG 

ADOBE PHOTOSHOP, ADOBE PRIEMERE  PRO DAN ADOBE 

AFTER EFFECTS CS6 

 

A. ADOBE PHOTOSHOP 

1. Pengertian Adobe Photoshop 

Photoshop atau disebut Photoshop adalah perangkat 

lunak editor citra buatan Adobe Systems yang 

dikhususkan untuk pengeditan foto/gambar dan 

pembutan efek. Perangkat lunak ini banyak digunakan 

oleh fotografer digital dan perusahaan iklan sehingga dianggap sebagai 

pemimpin pasar (market leader) untuk perangkat lunak pengolah 

gambar/foto dan bersama Adobe Acrobat, dianggap sebagai produk terbaik 

yang pernah diproduksi oleh Adobe Systems.  

 

2. Kelebihan Adobe Photoshop 

a. Mudah di operasikan. 

b. Banyak sekali fitur – fitur yang unggul. 

c. Bisa di gunakan untuk membuat tulisan dengan efek yang di 

inginkan. 

d. Bisa di gunakan untuk mendesain maupun untuk editing gambar. 

e. Bisa membuat beragam material. 

f. Fasilitas untuk editing lebih lengkap di banding lainnya. 

g. Bisa untuk rekayasa foto. 

h. Bisa menambah efek lagi meski sudah terlalu banyak efek. 
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i. Penyimpanan dapat menggunakan berbagai format. Format 

penyimpanan tidak sekedar PSD, namun JPEG dan yang lainnya. 

j. Photoshop lebih cepat kerjanya. 

 

3. Kekurangan Adobe Photoshop 

a. Banyaknya layer yang di gunakan 

b. Ukuran yang di butuhkan terlalu besar.  

 

 

B. ADOBE PREMIERE PRO 

1. Pengertian Adobe Premiere Pro 

Adobe Premiere merupakan sebuah aplikasi editing 

video komersial yang dikembangkan oleh perusahaan 

terkenal Adobe Systems.. 

Secara umum, Adobe Premiere berfungsi untuk 

merangkai gambar, video maupun audio menjadi sebuah 

konten yang sangat menarik untuk disajikan. 

 

2. Kelebihan Adobe Premiere Pro 

a. Mudah dalam membuat judul video karena memiliki 3 title. 

b. Dapat meng-capture video dari camcorder yang terhubung ke 

komputer atau laptop, dan dapat disimpan dalam format  file. 

c. Memiliki timeline yang dapat diisi dengan banyak video serta 

audio. 

 

3. Kekurangan Adobe Premiere Pro 

a. Memiliki ukuran instalasi yang besar. 

b. Membutuhkan spesifikasi komputer atau laptop yang tinggi. 

c. Tidak terdapat full screen preview. 
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C. ADOBE AFTER EFFECTS 

1. Pengertian Adobe After Effects 

Adobe After Effects merupakan  perangkat lunak 

profesional pengolah Motion Graphic  (Grafik Gerak 

Digital) untuk editing video serta efek visual. 

Adobe After Effects berfungsi sebagai penambahan efek 

khusus, seperti efek petir, efek hujan, efek salju, efek ledakan bom dan efek 

lainnya. 

 

2. Kelebihan Adobe After Effects 

a. Dukungan efek yang melimpah. 

b. Detail gambar yang halus saat kompresi. 

c. Dukungan keyframe dan scripting. 

 

3. Kekurangan Adobe After Effects 

a. Butuh waktu lama untuk mempelajarinya. 

b. Membutuhkan hardware dengan spesifikasi tinggi. 

c. Fungsi rendering teks yang tidak optimal.  
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MODUL 2 

MENGUBAH BACKGROUND FOTO POTRAIT 

MENGGUNAKAN ADOBE PHOTOSHOP CS6  

 

A. Langkah Kerja 

1. Siapkan terlebih dahulu foto potrait dan logo. Sesuai dengan keinginan 

kalian. 

 
 

2. Buka Adobe Photoshop CS6. 
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3. Pilih File > Open. 

 
 

4. Kemudian pilih foto potrait yang akan diubah background. 
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5. Kemudian tekan Ctrl+J untuk menggandakan layer. 

 
 

6. Setelah itu, seleksi foto potrait menggunakan Polygonal Lasso Tool. 

 
 

7. Seleksi foto potrait, hingga ujung seleksi bertemu dengan ujung seleksi 

pertama. Sehingga muncul garis putus-putus. 
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8. Setelah diseleksi, klik kanan pada foto, lalu pilih Feather. 

 
 

9. Kemudian isi Feather Radius dengan 2. Lalu, klik OK. 
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10. Kemudian Pilih File > New atau tekan Ctrl+N, untuk membuka lembar 

kerja baru. 

 
 

11. Setelah itu, ubah preset menjadi nama foto(IMG_2582.JPG), lalu klik OK. 
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12. Maka akan muncul lembar baru seperti ini. 

 
 

13. Lalu, pergi ke foto potrait yang sudah diseleksi tadi, dan tarik(drag) foto 

ke lembar kerja baru. 
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14. Pastikan sudah memilih background, karena saya ingin mengubah warna 

background. 

 
 

15. Kemudian pilih warna background, lalu klik OK. 

 
 

16. Kemudian gunakan Paint Bucket Tool, untuk mengubah warna 

background. 
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17. Lalu arahkan Paint Bucket Tool ke arah background, dan klik pada 

background. 

 
 

18. Setelah itu, saya masukkan logo yang sudah saya siapkan tadi. Pilih File > 

Open. 
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19. Kemudian pilih logo yang telah disiapkan. 

 
 

20. Kemudian tarik(drag) logo ke foto yang sudah diubah background-nya. 

 
 

21. Letakkan logo dibelakang foto potrait, dengan meletakkan layer 2 

dibawah layer.  
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22. Kemudian atur posisi logo. Untuk mengatur posisi logo, memperbesar atau 

memperkecil logo. Tekan Ctrl+T. 

 
 

23. Untuk menghilangkan jerawat atau bercak-bercak hitam dikulit, gunakan 

Patch Tool. 
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24. Arahkan Patch Tool ke bagian yang akan dihilangkan dari jerawat atau 

bercak-bercak hitam nya, lalu buatlah lingkaran menggunakan Patch Tool, 

dan tarik ke warna kulit yang lebih bersih. 

 
 

25. Jika foto tampak gelap, cerahkan dengan menekan Ctrl+L, digunakan 

untuk mencerahkan dan menggelapkan foto. 
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26. Jika sudah selesai, simpan foto dengan pilih File > Save As. 

 
 

27. Simpan foto sesuai dengan keinginan, dan ubah nama, sesuai dengan 

keinginan. Untuk menyimpan dalam format gambar, ubah format file 

menjadi JPG atau JPEG.  
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B. Hasil Dan Pembahasan 

 

   
 

Kedua gambar diatas merupakan hasil dari pengeditan mengubah 

background foto potrait menggunakan Adobe Photoshop CS6 Master 

Collection.  
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MODUL 3 

EDITING MENGGUNAKAN ADOBE PREMIERE PRO DAN 

ADOBE AFTER EFFECTS CS6  

 

A. Langkah Kerja 

1. Dokumentasikan video yang akan digunakan untuk pembuatan video 

profil menggunakan kamera DSLR Canon 60D dan Sony Handycam. 

2. Kemudian, siapkan video mentah yang akan digunakan dalam folder. 

  

 

3. Buka Adobe Premiere Pro CS6. 
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4. Lalu, pilih New Project dan pilih lokasi penyimpanan projek dan 

sesuaikan nama projek dengan keinginan anda. Klik OK.  

 
 

5. Kemudian, pilih video yang tadi telah disiapkan. 
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6. Selanjutnya, tarik (drag) video yang telah dipilih ke bagian timeline. 

 
 

7. Cara memasukkan audio ke dalam timeline, sama hal nya dengan 

memasukkan video, tapi terlebih dahulu meng-import audio yang 

dibutuhkan. Pergi ke bagian Project Window, lalu klik kanan pada bagian 

kosong dan pilih import, lalu tarik (drag) ke bagian timeline. 

  
 

8. Lakukan pengeditan video yang berada di timeline sesuai dengan 

keinginan. 

 

9. Agar video yang dibuat terlihat menarik dan seperti video yang dibuat 

oleh seseorang yang profesional, kita dapat menambahkan beberapa efek 

yang menarik menggunakan Adobe After Effects.  
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10. Buka terlebih dahulu Adobe After Effects. 

 
 

11. Lalu pilih New Composition. Maka akan muncul sebuah pengaturan untuk 

setting nama, ukuran background, waktu durasi video, dan warna 

background, setelah kalian meng-edit sesuai keinginan. Lalu klik OK. 
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12. Selanjutnya, saya akan membuat salah satu efek untuk mempercantik 

video yang saya buat. Pilih Layer > New > Solid. 

 
 

13. Pilih Color berwarna merah hati. Lalu, klik OK. 
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14. Kemudian, sesuaikan ukuran solid sesuai yang dibutuhkan. 

 
 

15. Lalu, buat solid menjadi 2 buah. Tapi dengan warna yang berbeda. 

Sehingga seperti ini hasilnya. 
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16. Setelah itu, tambahkan teks pada bagian solid. Dengan cara klik kanan 

pada bagian Layer, pilih New > Text. 

  
 

17. Sehingga seperti ini tampilannya. 

 
 

18. Setelah efek yang dibuat selesai, kemudian masukkan efek ke dalam video 

yang dibuat. Dengan cara buka terlebih dahulu projek video yang di buat 

di Adobe Premiere Pro CS6, lalu pilih File > Adobe Dynamic Link > 

Import After Effectss Composition. 
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19. Kemudian, pilih efek yang ingin dimasukkan ke dalam video. Lalu, klik 

OK. 
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20. Setelah itu, tarik (drag) efek yang telah di import ke bagian timeline. 

 
 

21. Setelah edit video selesai, maka dilanjutkan dengan me-render video 

tersebut. Pilih File > Export > Media. 
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22. Render video kedalam format .mp4. 
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MODUL 1 

A. Langkah Kerja 

1. Langkah pertama buka Adobe Flash Professional CS6. 

 

 

2. Kemudian, pilih Create New memakai ActioScript3.0. 
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3. Kemudian akan menampilkan tampilan seperti gambar dibawah ini. 

 

 

4. Pilih File + Import + Import to Stage. 
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5. Pilih gambar yang akan di import, kemudian delete kembali. Akan tetapi 

gambar tadi tersimpan di Library. 

 

 

6. Kemudian buatlah background menggunakan Rectangle Tool seperti pada 

gambar dibawah ini. Kemudian atur background supaya sama dengan 

lembar kerja yaitu w 800 x h 600 x=0 y=0. 
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7. Selanjutnya double klik pada backround kemudian pilih Color + 

Backround + Solid Color diubah ke Bitmap Fill. 

 

 

8. Kemudian membuat teks menggunakan Teks Tool, warna teks hitam, 

Size=40, Format Center, Static Teks, Align Horizontal Center, Family 

Teks=Comic Sans MS, Style Teks=Bold, untuk Family Teks-nya di embed 

data aktifkan all character ranges kemudian OK. 

 

 

 

 



 33 

 

9. Untuk penambahan efek pada teks dapat menggunakan glow warna putih 

dan Drop Shadow warna abu-abu ringan. 

 

 

10. Kemudian buatlah teks seperti pada gambar dibawah ini untuk isi nama 

dan no absen teks nya harus Align Horizontal Center. 
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11. Untuk teks nama dan no absen menggunakan format Align Left. 

 

 

12. Kemudian untuk membuat nama dan no absen dapat menggunkan teks 

kemudian pilih input text, pilih Show Around Border Text. 

 

 

13. Kemudian tambahkan tombol masuk menggunakan Oval Green yang 

terdapat pada External Library ubahlah teks Enter menjadi masuk untuk 

penamaan Instanname pada tombol masuk yaitu ke soal. 
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14. Selanjutnya tambahkan layer baru untuk mengisi Action-nya seperti 

gambar dibawah ini. 

 

 

15. Tambahkan dua layer baru untuk penambahan background tambahan 

seperti pada gambar dibawah ini, dan kemudian kedua background ini 

digabungkan. Kemudian pilih Convert To Symbol pilih Movie Clip. 
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16. Kemudian tambahkan layer baru diatas layer 5 untuk membuat teks. 
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17. Untuk selanjutnya penambahan layer untuk Dynamic Text. 

 

 

18. Langkah selanjutnya tambahkan layer baru untuk penambahan tombol 

button ABCD yang akan di buat untuk pilihan jawaban dari soal. 
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19. Kemudian untuk penambahan teks pada button menggunakan teks tipenya 

static.  

 

 

20. Penambahan OK-icon. 

 

 

21. Selanjutnya penambahan icon kembali yaitu Pilih File + Import + Impot 

to Stage, kemudian pilih gambar yang ingin di import, selanjutnya Covert 

to Symbol + Movie Clip + Convert to Symbol + Button dan didalam ada 

teks seperti pada gambar dibawah ini. 
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22. Selanjutnya jangan lupa memberi nama setiap Button, Dynamic Text 

supaya lebih mudah dalam pembuatan ActionScript, bisa kita lihat seperti 

gambar dibawah ini contoh Action-nya. 
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23. Dibawah ini adalah tampilan gambar action penambahan dari action yang 

pertama. 
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MODUL 2 

A. Langkah Kerja 

1. Tambahkan frame pada layer action untuk melanjutkan jawaban yang 

sebelumnya pilihan jawaban soal no 1 hanya pada button A saja. 

Kemudian pindahkan jawaban soal yang ke 2 pada button B dan 

dilanjutkan sampai dengan soal yang ke 5 kembali lagi ke button A. 

Dibawah ini gambar tampilan action. 

 

 

2. Pada layer 5 dan 9 insert keyframe kemudian duplicate symbol pada layer 

ke 5, kemudian masuk kedalam symbol hapus symbol sebelah kanan atas, 

kemudian aturlah posisi symbol yang dikiri menjadi Center Horizontal 

Align seperti pada gambar dibawah ini. 
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3. Tambahkan frame pada layer 4. 

 

 

4. Pada layer 9 copy Nama dan No Absen seperti pada gambar dibawah ini, 

kemudian tipe teks diubah dari Input Text menjadi Dynamic Text 

hilangkan border pada teks. 
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5. Selanjutnya membuat garis pembatas menggunakan Line Tool warna 

putih seperti pada gambar dibawah ini. 

 

 

6. Selanjutnya copy symbol Nama dan No Absen kemudian ganti teks 

dengan Nilai Kamu. Hal yang sama dilakukan juga dengan Dynamic Text 

ukurannya atur 60 saja untuk menampilkan nilai dari data yang nilai 

seperti pada gambar dibawah ini. 
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7. Kemudian untuk pembuatan tombol kembali pilih pada Eksternal 

Libarary kemudian pilih playback-loop, kemudian masuk kedalam 

tombol lalu tambahkan layer baru untuk membuat teks. Ulangi seperti 

pada gambar dibawah ini.  

 

 

8. Selanjutnya Insert Keyframe pada layer 3 untuk Action. Tapi jangan lupa 

untuk penamaan pada setiap Instaname supaya memudahkan untuk 

membuat Action pada animasi nantinya, dibawah ini adalah tampilan 

gambar Action.  
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B. Hasil Modul 2 
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MODUL 3 

A. Langkah Kerja 

1. Langkah pertama buka aplikasi Adobe Flash Professional yang telah 

diinstal dikomputer masing-masing. 

 

 

2. Kemudian setelah dibuka akan muncul tampilan seperti gambar dibawah 

ini lalu pilih ActionScript3.0. 
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3. Kemudian atur size lembar kerja 800 x 600 dan atur fit ini windows seperti 

pada gambar dibawah ini. 

 

 

4. Kemudian untuk membuat background warna dapat memakai rectangle 

tool atur warna sesuai dengan keinginan masing-masing.  
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5. Untuk mengatur warna bisa menggunakan pengaturan warna sesuai 

dengan tampilan gambar seperti dibawah ini. 

 

 

6. Aturlah warna background sesuai dengan keinginan masing-masing 

contohnya seperti pada gambar dibawah ini. 
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7. Setelah pengaturan warna dapat diatur juga pengaturan background diatas 

dengan cara mengubah ukuran w dan h nya sesuai dengan backround awal 

dan untuk ukuran x dan y nya diatur 0 saja seperti tampilan gambar 

dibawah ini. 

 

 

8. Kemudian buatlah layer baru. 
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9. Untuk pembuatan garis dapat menggunakan line tool untuk pewarnaan 

garis dapat menggunakan warna putih. 

 

 

10. Garis yang akan dibuat menggunakan garis putus-putus yaitu bisa dilihat 

dipengaturan style-nya seperti pada gambar dibawah ini yaitu dari solid 

diubah ke dashed. 
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11. Untuk membuat animasi garis dapat kita klik kanan pada garis kemudian 

pilih convert to symbol seperti pada gambar dibawah ini. 

 

 

12. Kemudian pilih pengaturannya seperti pada gambar dibawah ini. 
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13.  Kemudian klik dua kali pada garis untuk masuk ke symbol. 

 

 

14. Kemudian copy garis dan pisahkan pada layer yang berbeda. 
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15. Kemudian paste in place pada layer baru. 

 

 

16. Pisahkan garis pada layer masing-masing seperti pada gambar dibawah 

ini.  
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17. Selanjutnya untuk membuat animasi pada garis dapat menggunakan create 

classic tween seperti pada gambar dibawah ini. 

 

 

18. Tambahkan insert keyframe pada frame 60. 
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19. Ubah lah posisi garis yang setelah di tambahkan key farme.  

 

 

20. Selanjutnya insert key frame lagi pada frame 120 ubahlah letak posisi garis 

untuk membuat animasi setelah dijalankan. 
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21. Untuk frame yang ke 180 di copy saja frame yang 60 tadi supaya animasi 

nya terlihat berulang-ulang. 

 

 

22. Paste frame pada frame 180. 
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23. Kembali lagi ke scene 1 untuk tambahan intro pada backround dapat 

menggunakan rectangle tool kemudian warna diubah warna putih saja. 

 

 

24. Kemudian kita convert to symbol pada kotak tadi. 
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25. Kemudian pilih move clip untuk membuat animasi pada kotak tadi. 

 

 

26. Klik dua kali untuk masuk pada symbol move clip untuk pembuatan 

animasi sama hal nya seperti garis diatas setiap kotak dipisahkan layer-

nya. 
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27. Kemudian supaya warna yang terdapat pada kotak tidak terlalu pekat 

untuk pengaturan alpha-nya diatur 17%. 

 

 

28. Selanjutnya untuk membuat teks pilih teks tool kemudian untuk ukuran 

teks atur size-nya 27 untuk font nya di-embed. 
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29. Untuk pengaturan embed bisa dilihat pada gambar dibawah ini. 

 

 

30. Untuk pewarnaan teks bisa diubah menjadi warna ungu seperti pada 

gambar dibawah ini. 
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31. Untuk size-nya diatur ukurannya menjadi 40 dan posisinya di center saja. 

 

 

32. Kemudian menggunakan align center.  
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33. Untuk kesamaan teks selanjutnya copy saja. 

 

 

34. Kemudian paste in place. 
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35. Kemudian ubah teks yang di-copy tadi menjadi media pembelajaran 

interaktif seperti tampilan gambar dibawah ini. 

 

 

36. Kemudian atur font dan size-nya seperti pada gambar dibawah ini. 
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37. Kemudian untuk meng-import foto kita dapat mengklik file kemudian pilih 

import kemudian pilih import to stage.  

 

 

38. Kemudian pilih gambar yang akan dimasukkan kedalam stage tadi seperti 

pada gambar dibawah ini.  
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39. Untuk pengaturan posisi gambar bisa menggunakan align kemudian pilih 

center. 

 

 

40. Kemudian covert to symbol. 
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41. Kemudian movie  clip + OK. 

 

 

42. Klik kanan lagi kemudian covert to symbol lagi.  
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43. Kemudian ubah dari movie clip menjadi button + OK. 

 

 

44. Kemudian masuk ke symbol button untuk pembuatan button yang terdapat 

pada gambar. 
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45. Untuk pembuatan teks masuk. 

 

 

46. Seperti pada gambar dibawah ini.  
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47. Insert frame pada layer 2. 

 

 

48. Insert keyframe pada layer 1. 
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49. Tambahkan layer didalam symbol seperti gambar dibawah ini. 

 

 

50. Selanjutnya untuk tombol masuk bisa diatur drop shadow. 



75 

 

51. Pewarnaan warna kuning.  

 

 

52. Kemudian untuk setelah di klik drop shadow kembali untuk pewarnaan 

diubah menjadi grey. 
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53. Untuk penggabungan semua layer bisa CRTL+Shift pilih convert to 

symbol. 

 

 

54. Kemudian klik movie clip+OK. 
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55. Kemudian masuk kedalam movie clip pisahkan layer pada setiap teks atau 

button. 

 

 

56. Untuk pembuatan animasi dapat menggunakan motion teween yang sesuai 

tampilan gambar dibawah ini. 
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57. Tambahkan layer baru kemudian untuk action dibuat stop(); supaya 

animasi tidak berulang-ulang. 

 

 

58. Hasilnya seperti pada gambar dibawah ini. 
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MODUL 4, 5 DAN 6 

A. Langkah Kerja 

1. Pada tutorial ke 4 ini yang bersumber dari video tutorial Junior Dev, pada 

tutorial ke 4 ini kita akan meng-import icon, dan juga meng-import musik 

seperti di bawah ini :  

 

 

2. Untuk meng-import musik cara nya juga sama file-import-to stage dan pilih 

musik yang ingin kalian masukkan. 
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3. Nah kodingan untuk menjalan kan musik. 

 

 

4. Kodingan untuk menghentikan musik. 
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5. Sebelumnya icon yang sudah kita import itu di convert menjadi movie clip 

terlebih dahulu dan juga di convert menjadi button.  

6. Selanjutnya kita akan input button close seperti di bawah ini, caranya sama 

dengan tutorial diatas :  

 

 

7. Fungsi dari button ini adalah sebagai tombol close animasi pada saat kita 

jalankan. Sebelumnya button ini kita convert terlebih dahulu menjadi 

button dan di convert lagi menjadi movie clip. Untuk kodingan button close 

nya di bawah ini :  
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8. Nah selanjutnya kita tambah sebuah layer baru yang berfungsi sebagai 

halaman untuk keluar seperti di bawah ini :  

 

 

9. Cara kerjanya adalah ketika button close di klik secara otomatis akan di 

redirect ke layer kedua atau halaman keluar seperti gambar di atas. Nah 

selanjutnya kita akan membuat kodingan close nya seperti di bawah ini : 
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10. Cara kerja nya adalah ketika button quit_OK di klik dia akan kembali ke 

quit1 dan jika quit_c di klik maka akan kembali ke quit2. Maksudnya 

ketika button OKe di klik akan langsung keluar dari animasi dan jika button 

cancel di klik maka animasi tidak akan keluar. 

 

11. Selanjutnya pada tutorial video yang kelima kita akan membuat menu atau 

halaman utama dari animasi nya, contoh halaman nya seperti di bawah ini :  

 

 

12. Pada tutorial ini agak sedikit mudah karna tidak ada membuat 

kodingannnya. Disini kita tinggal meng-import gambar, animasi berjalan, 

dan juga membuat tulisan. Pada gambar di atas sudah saya berikan kotak-

kotak merah untuk menentukan menu-menu yang akan di input. Dari 

gambar di atas ada animasi berjalan untuk hewan, dan awan. Untuk 

membuat teks itu sudah di sediakan tool-nya okel adobe flash itu sendiri. 

 

13. Tutorial ini merupakan kelanjutan dari tutorial sebelumnya, pada tutorial 

kali ini kita akan menambahkan beberapa layer baru dan menu kembali. 
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14. Sebelumnya kita beri nama setiap button terlebih dahulu seperti di bawah 

ini : 

 

 

15. Untuk button materi, video dan quiz juga di beri instan name sesuai dengan 

nama button-nya masing-masing. 

 

 

16. Ini merupakan kodingan untuk tutorial yang ke enam. Kodingan ini berisi 

perintah jika menu kd di klik dia akan ke redirect ke layer berikutnya yang 

diberi nama ke_kd, begitu juga dengan materi, video dan quiz. Penamaan 

dari setiap layer harus sama dengan yang di kodingan agar tidak terjadi 

error. 
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17. Selanjutnya kita tinggal menambahkan beberapa layer untuk hasil redirect 

ketika button-button materi, video, quiz di klik, seperti di bawah ini :  
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18. Untuk background dari layer-layer tersebut tinggal di import dari library 

seperti kita meng-import gambar sebelumnya. Selanjutnya tinggal 

tambahkan teks sesuai dengan nama button atau materi pembelajaran nya. 
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19. Selanjutnya tambahkan button seperti di bawah ini : 

 

 

20. Fungsi dari button ini nantinya sebagai tombol kembali ke halaman utama 

atau menu utama. Sebelumnya button ini sudah di convert menjadi movie 

clip. Jangan lupa berikan instan name untuk button ini seperti di bawah ini :  

 

 

21. Instan name ini fungsinya untuk penamaan button agar mudah di panggil di 

kodingan. Untuk fungsi callback atau kodingan untuk menu kembali seperti 

di bawah ini : 
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22. Gambar di atas adalah kodingan untuk button kembali_menu sesuai instan 

name yang sudah kita buat sebelumnya, perintahnya adalah jika button 

kembali_menu di klik maka dia akan kembali ke menu utama. Nah 

kodingan ini tinggal kita copy kan saja ke actionscript menu yang lainnya. 

 

23. Membuat kotak menggunakan rectangle tool border menggunakan warna 

hijau dan fill color menggunakan warna hijau muda, lalu centang pada 

object drawing lalu klik properties dan ubah strOKe-nya menjadi tiga dan 

style menjadi dashed. Lalu sebelum membuat kotak mengisi radius terlebih 

dahulu ubah menjadi sepuluh, setelah itu jadikan dia movie clip seperti 

gambar dibawah ini: 
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24. Tambahkan layer baru lalu klik window+commont 

libraries+button+bubble glow green, lalu tarik ke frame layer lalu duplikat 

button tersebut, seperti gambar dibawah ini:  

 

 



91 

 

25. Lalu tambahkan label kompetensi dasar dan indikator pada button, lalu 

tambahkan glow dengan warna putih dan strength menjadi 1000, lalu 

membuat actions untuk menjalankan tombol buttons, dan begitu juga untuk 

buttons selanjutnya. seperti gambar dibawah ini : 

 

 

26. Membuat garis untuk buttons menggunakan line lalu klik kanan pada garis 

lalu arrange+send to backward=send to back seperti gambar dibawah ini : 
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27. Membuat layer baru lalu tambahkan teks untuk membuat isi dalam 

kompetensi dasar dan indikator menngunakan icon teks dengan mengubah 

ukuran tulisan dan jenis  font yang kita inginkan seperti gambar di bawah 

ini : 
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28. Membuat sub menu untuk materi, pertama tambahkan layer diatas layout 

lalu convert to keyframe lalu klik file+import+import to stage, lalu pilih 

beberapa gambar island, meal, lung, run, shell dan egg, lalu atur posisinya 

seperti gambar dibawah ini : 

 

 

29. Lalu membuat teks pada setiap gambar dan tambahkan icon untuk 

penggolongan binatang menggunakan object drawing, lalu untuk 

mengubah convert to symbol pada setiap icon penggolongan binatang nya 

di ubah menjadi button, dan untuk memberi effect pada button yang 

berguna untuk jika button di klik akan memberikan perbedaan atau 

peubahan warna, dengan menggunakan glow dan ubah warnanya menjadi 

putih dengan nilai strength-nya 1000 dan blur X dan Y 15 dan begitu juga 

pada button selanjutnya seperti gambar di bawah ini : 
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30. Lalu untuk membuat garis klik line tool dan centang lagi untuk drawing 

object, sebelum membuat garis atur fill dan strOKe-nya terlebih dahulu 

dengan klik properties lalu ubah strOKe menjadi satu dan style-nya 

menjadi dashed, lalu tarik garis untuk menghubungkan button seperti 

gambar di bawah ini : 
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31. Untuk mengaktifkan semua buttons agar bisa di klik, langkah selanjutnya 

yaitu membuat actions-nya seperti gambar di bawah ini: 

 

 

32. Lalu membuat layer baru dan key frame baru, di frame dua klik kanan lalu 

insert key frame, lalu import sebuah image dengan cara klik 

file+import+import to stage untuk membuat tombol untuk kembali lalu 

pilih icon action reload icon dan letakan di bagian pojOK kiri atas lalu buat 

teks menggunakan teks tool lalu blOK keduanya untuk di jadikan satu 

tombol dengan cara convert to symbol dengan type movie clip, lalu masuk 

ke button over lalu insert key frame, lalu tambahkan glow dengan warna 

putih dan strength 1000 blur X dan Y 10, lalu down  kita berikan key frame 

F6 dan ubah warnanya menjadi warna kuning seperti gambar di bawah ini: 
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33. Lalu tambahkan teks untuk mengisi bagian dalam pada buttons yang sudah 

di buat sebelumnya, begitu juga untuk buttons-buttons selanjutnya, dan 

selanjutnya kita akan membuat layer baru di atasnya layer tiga lalu klik 

kanan insert key frame, untuk frame pertama kita masuk ke properties 

dengan mengubah namanya menjadi menu_materi, dan untuk label ke dua 

mengarah ke M1 maka di layer 5 frame-nya juga di kasih nama M1 begitu 

juga seterusnya  seperti gambar di bawah ini : 
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34. Lalu tambahkan layer baru di atas layer 3, lalu insert key frame untuk 

menentukan jenisnya seperti gambar di bawah ini: 
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MODUL 7 

MEMASUKKAN VIDEO KEDALAM ANIMASI 

A. Langkah Kerja 

1. Sebelumnya kita sudah menyelesaikan content pada tutorial sebelumnya, 

selanjutnya kita akan memasukkan video kedalam media pembelajaran 

yang sedang kita buat. 

 

2. Disini kita akan membuat tombol navigasi untuk berpindah dari video satu 

ke video dua. 
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3. Sebelumnya kita akan membuat border untuk content video terlebih 

dahulu. 

 

 

4. Setelah border selesai di buat lalu kita double klik pada border tersebut. 

 

 

5. Setelah di double klik kita akan masuk pada frame baru, setelah itu kita 

bisa menambahkan tombol kedalam frame. 
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6. Setelah kita memasukkan tombol kedalam layer baru tersebut, double klik 

pada tombol lalu hapus teks yang ada dalam tombol, setelah itu atur dan 

sesuaikan ukuran tombol yang kita butuhkan. Lalu lakukan paste and place 

ke sebelah tombol sebelumnya. Lalu kita bisa mengganti warna sesuai 

kebutuhkan kita. Setelah itu kita berikan keterangan atau kita berikan teks 

pada tombol menggunakan text tool. 
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7. Setelah itu kita memberikan teks pada tombol kita akan memberikan action 

pada kedua tombol. Sebelumnya kita tentukan dulu instant name dari kedua 

tombol tersebut. Setelah itu baru kita berikan action seperti gambar di 

bawah ini. 
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8. Setelah itu buat layer baru untuk  tempat video yang akan kita masukkan. 

Dan jangan lupa untuk insert frame sebelumnya, dan berikan key frame 

baru pada setiap layer baru yang kita buat. Lalu setelahnya kita import 

video. 
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9. Setelah video di import kita drag dan sesuaikan ukurannya pada layer, ada 

beberapa hal yang harus diperhatikan ketika memasukkan video kedalam 

flash, semakin besar ukuran video yang kita masukkan maka akan semakin 

besar juga ukuran file flash yang kita buat. Setelah itu kita berikan action 

seperti gambar dibawah ini. 

 

 

10. Jika sudah kita bisa mencoba menjalankan animasinya. Karena tidak ada 

pemberitahuan error maka video dapat berjalan dengan baik didalam flash. 
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MODUL 8 

MEMBUAT QUIZ PADA MEDIA PEMBELAJARAN 

INTERAKTIF MENGENAL BINATANG 

A. Langkah Kerja 

1. Kali ini kita akan mencoba atau membuat sebuah quiz pada media 

pembelajaran interaktif yang sebelumnya sudah kita buat, kali ini kita akan 

membuat quiz yang bersifat isian. Pertama-tama kita siapkan dulu header 

atau judul dari quiz yang akan kita buat. 

 

 

2. Lalu setelah itu kita akan masukkan sebuah tombol atau button kedalam 

layer yang nantinya akan digunakan untuk memulai quiz tersebut. Caranya 

sama dengan cara pada tutorial sebelumnya. 
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3. Setelah itu kita atur sesuai dengan keperluan, setelah itu double klik pada 

tombol yang telah dibuat lalu atur seperti kita mengatur pada modul 

sebelumnya. Setelah itu kita berikan action pada tombol tersebut, 

sebelumnya jangan lupa memberikan instant name pada tombol. 

  



106 

 

4. Setelah kita membuat action pada layer 2, kita buat layer baru yaitu layer 3 

yang akan digunakan untuk membuat template untuk quiz yang akan kita 

buat. Buat template yang sesuai dengan kebutuhan kita.  

 

 

5. Setelah membuat template, kita akan membuat layout untuk hint dari quiz 

yang akan kita buat, disini kita menggunakan layout dari button yang 

tersedia di flash. 
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6. Setelah itu buat beberapa kolom sesuai kebutuhan kita untuk meletakkan 

hint atau bantuan untuk menjawab pertanyaan.  

 

 

7. Selanjutnya kita buat kolom untuk meletakkan jawaban dari quiz tersebut 

menggunakan rectangle tool. 
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8. Setelah itu kita akan membuat button untuk memasukkan jawaban yang 

dari quiz yang kita buat. 

 

 

9. Setelah itu kita isi hint dari quiz tersebut menggunakan text tool. 
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10. Lalu kita akan membuat layout untuk pemberitahuan benar atau salah 

jawaban yang kita berikan.  
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11. Setelah itu kita buat lagi key frame untuk membuat action, sebelumnya kita 

akan import sebuah button utuk melanjutkan quiz. 

 

 

12. Setelah itu kita berikan action pada button dengan kodingan seperti 

dibawah ini. 
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13. Dan jangan lupa untuk membuat pemberitahuan jika jawaban yang kita 

masukkan salah. Kita bisa meng-copy frame pemberitahuan sebelumnya, 

lalu mengganti warna background dan button yang ada.  

 

 

14. Lalu buat action untuk pemberitahuan salah seperti gabar dibawah ini. 
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15. Lalu buat layer baru dan berikan action seperti gambar dibawah ini. 

 

 

16. Jika sudah kita bisa mencoba menjalankannya. 
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MODUL 9 

SCREENSHOT FLASH MENJADI GAMBAR JPG 

DENGAN ACTIONSCRIPT 3 

A. Langkah Kerja 

1. Kali ini kita akan membuat screenshot flash menjadi gambar berformat 

JPG dengan actionscript3. Nantinya kita akan bisa langsung menyimpan 

gambar screenshot dari flash. 

 

2. Petama kita buat lembar baru atau layer pada workspace dan buat template 

seperti gambar dibawah ini. 
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3. Setelah itu berikan action seperti gambar dibawah ini.  
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